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Introduction

ParaWin ME Pro is the software package that enhances multilingual
capabilities of Windows 95/98 & ME operating systems. The program also
expands your font collection by adding a set of TrueType Fonts supporting
six different code pages (scripts).

ParaWin ME Pro Features

•Full control over keyboard layouts allowing adding, grouping and
editing existing layouts as well as creating the new ones.

•Advanced keyboard switching capabilities include an extensive list of
“Hotkey” selection and context independent system�wide switching.

•Three possible Layout/Language indicator modes: taskbar indicator,
movable keyboard window and resizable keyboard viewer.

•Full featured keyboard layout editor with an advanced, customizable
“Dead key” function in addition to AltGr  and Caps Lock modes.

•Capability to select different combinations of system and DOS text
conversion fonts among six different character sets (Code Pages).

ParaWin ME Pro Package

• ParaWin ME Pro 3 3.5�inch disks with 1.4 MB capacity or CD�ROM

• ParaWin ME Pro User's Guide

• License Agreement

• Registration Card

Make sure to fill out and return the enclosed registration card to Smart
Link Corporation.  Only registered customers are eligible to receive our  high�
quality technical support.
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Introduction

System Configuration Requirements

• Hard disk with 5 MB of free disk space

• 3.5" Floppy disk drive

• Windows 95, 98 or ME operating system

Note: PARAWIN ME PRO IS COMPATIBLE WITH ALL APPLICATIONS RUNNING
UNDER WINDOWS 95, 98 or ME COMPLIANT WITH ITS STANDARD INPUT�
OUTPUT PROCEDURES.
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Chapter 1
Installation of ParaWin ME Pro

ParaWin ME Pro Setup Wizard will help you to install and activate Keyboard
Driver, Viewer and Editor modules along with the system and True Type
multilingual fonts.

Note: THIS PACKAGE IS DESIGNED FOR INSTALLATION ON A SINGLE,
STAND�ALONE COMPUTER SYSTEM.

1. Insert ParaWin ME Pro distribution diskette #1 or CD�ROM into the
appropriate disk drive.

2. Click the Start button on the Taskbar and choose Run.

3. Type “a:setup” (or “d:setup” ) and press OK or Enter.

4. ParaWin ME Pro Installation window will appear.

5. Follow ParaWin ME Pro Installation Wizard instructions.

Choose an additional keyboard layout to make active. You will be able
to add more layouts after the installation.
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Installation of ParaWin ME Pro

Select the “Hotkey” to switch between keyboard layouts. You will be able to
change  the “Hotkey” selection after the installation.

During the installation you should select one of the available language
settings.
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During the ParaWin ME Pro installation, Setup will prompt you to select
one of the following pairs of the standard character sets:

      Windows CP                                 MS�DOS CP
Cyrillic 1251 866
Western 1252 437
Central European 1250 852
Baltic 1257 775
Turkish 1254 857
Greek 1253 737

Any changes in Code Page settings after the installation could be
accomplished using  ParaWin ME Pro Properties.

The Installation Wizard will copy the program files onto your hard disk
and will update the system information after the restart  of  Windows™ 95,
98 or ME.

Note: You can terminate the installation of ParaWin ME Pro at any time by
choosing the Cancel button.

After the program has been successfuly installed, you will be able to find
shortcuts to ParaWin ME Pro in the Program menu.

ParaWin ME Pro Icon appears also in the Control Panel.

Installation of ParaWin ME Pro
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Uninstalling ParaWin ME Pro

You can uninstall ParaWin ME Pro by using one of the following procedures:

Double�click the “Uninstall ParaWin ME”
shortcut in ParaWin ME Pro Program
menu. This will activate UninstallShield
which will completely remove all
ParaWin ME Pro components and restore
your system settings.

Or, in Control Panel select ParaWin ME from  the list of the installed
programs, click  the “Add/Remove ” button.

Note: You have to restart your system to complete the uninstallation process.

Installation of ParaWin ME Pro
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Chapter 2
Starting ParaWin ME Pro

ParaWin ME Pro starts up and runs automatically each time Windows™ 95,
98 or ME is started.

In order to set desired languages and keyboard layouts in the ParaWin ME
Properties panel, the following steps should be taken:

Click the Start button, select  Settings and then Control Panel.

Locate ParaWin ME Pro Icon in the Control Panel and double�click.

ParaWin ME Properties window will appear:
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Click the Add button, and choose the desired language layout from the drop�
down list.  Click OK.

Make sure that the Keyboard
indicator and viewer properties
check boxes “Enabled” and “On the
Taskbar” are checked.

Click the Properties button to open the Keyboard Layout Properties panel.

From this menu you can change the “Hotkey”combination to be used for
fast switching between different keyboard layouts.

Starting ParaWin ME Pro
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The Language Indicator On the TaskBar represents a two letter abbreviation
of the language.

For example, “Ru” for Russian, “En” for English or “Uk” for Ukrainian.

Use the mouse to switch between languages/
layouts and select the desired language from the
list.  Or, use the Hotkey (key combination).

Starting ParaWin ME Pro
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Chapter 3
Basic Operations

Keyboard Viewer

The Keyboard Viewer operates in the following three modes:

• Taskbar Indicator mode (default)
• Layout Viewer mode
• Movable Keyboard Indicator (or Collapsed Viewer) mode

After the installation of ParaWin ME Pro and the restart of Windows, the
language indicator appears on the right side of the Taskbar.

• Place your mouse pointer on the indicator and click the left mouse
button.  The list of currently available languages/layouts will “pop up”.
The currently active layout/language is designated with the check
mark.

• Clicking the right mouse  button opens the submenu with Open
Viewer and Properties.

The Open Viewer menu item will bring up the Keyboard Layout Viewer.
You may prefer to use this mode, if you are not familiar with the
current keyboard layout.

Check mark  Always�on�top box in the ParaWin ME Pro Properties window
to display the Viewer on your screen.
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Click the right mouse button on the Keyboard Viewer caption bar to open
its menu.

Move,  Size and Close are three standard Windows options.

The lower part of the menu contains the following ParaWin ME options:

Collapse — switches Viewer to Movable Keyboard Indicator window.

In this mode the right mouse button brings up the same menu as in the
Viewer mode, but Collapse option changes it into the Explode option that
switches ParaWin ME Pro back into the full Viewer mode.

Properties — opens ParaWin ME Pro Control Panel.

Set Font — lets you select font for the Viewer window.

Switch Layout —switches between installed keyboard layouts.

Basic Operations
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Entering Text in Multiple Languages

To enter text in multiple languages you will need to have the fonts
supporting these languages, as well as the appropriate keyboard layouts
allowing access to the proper characters.

Fonts

The smallest element of a writing system is a Character.
In a computer system all characters are represented by numbers.

A system of characters governed by a general set of rules for creating text
for one or several languages is called Script or Character Set.

The internal table containing an orderly organized character set and
used by the operating system to relate the keys on the keyboard with the
characters displayed on the screen and printed on the printer is defined
as a Code Page.

A Font is a graphical representation of a character which is utilized to
display text on  screen, and to print it on paper or other visual media.

There are two types of fonts which could be used in Windows 95, 98 or ME
operating environment � Single�byte and Double�byte fonts.

US and Pan European versions of Windows 95, 98 or ME were designed to
work with 6 standard character sets (or scripts) organized in the following
code pages:

Code Page 1250 — Central European (CE)

Code Page 1251 — Cyrillic (Cyr)

Code Page 1252 — Western

Code Page 1253 — Greek (Greek)

Code Page 1254 — Turkish (Tur)

Code Page 1257 — Baltic (Baltic)

Basic Operations
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The double�byte fonts in Windows 95, 98 or ME are represented in the
application menus by fonts designated for a specific script.

Basic Windows TrueType fonts — Arial, Courier New and Times New
Roman are double�byte fonts, designed to support all 6 scripts.

The set of fonts included in the ParaWin ME Pro package are also double�
byte, multilingual fonts supporting all 6 scripts.

Note: If you would like to use some other fonts, you need to make sure that
scripts are supported by those fonts.

Keyboard Layouts

The ParaWin ME Pro package includes a comprehensive set of keyboard
layouts for many languages.

Some languages are supported by several keyboard layouts. For example, for
Russian language you may use Russian — standard layout for computers,
Russian (Translit) — Russian phonetic QWERTY layout or  Russian
(Typewriter) — the standard layout for Russian typewriters.

If for some reason, none of the available layouts is satisfying your
requirements,  you can create your own, custom keyboard layout using
Keyboard Layout Editor, described in Chapter 4.

Basic Operations
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Chapter 4
Setting Up ParaWin™ ME Properties

To setup ParaWin ME Pro properties:

• Either point the cursor on the language/layout Indicator located on the
Taskbar, click right mouse button and select Properties;

• Or click the right mouse button on the ParaWin ME Viewer caption bar
and select Properties;

• Or double�click the ParaWin ME Pro icon in the Control Panel;

• Or  access ParaWin ME Properties from Start\Programs\ParaWin
ME\ParaWin ME Control Panel.

Keyboard Layout Controls

The list of the installed keyboard
layouts is displayed in the
ParaWin ME Pro Properties win�
dow.
You may Add or  Remove any of
the layouts as well as make
changes in their Properties.
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Adding Layout

To add layout, click the Add button.

Select a layout from the list of available layouts. If the desired selection is
not available, you can install it from a file. Click From file… button to install
a new layout from a file with the extension  .KBD.

Select a file containing the desired keyboard layout  and click OK.

Setting Up ParaWin™ ME Properties
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Removing Layout

Click the Remove button in the ParaWin ME Propeties window.

If you check the box “Remove layout file from the disk” the corresponding
file will be removed from your system.

Layout Properties

In the Keyboard Layout Properties window you can view and edit the layout
properties.

In this window you can change the layout Indicator label and assign a
hotkey combination to switch between languages/layouts.
The Advanced… button opens the window used for setting up an alternate
hotkey combination, and allows a direct access to a specific language/
layout.

For example, you may want
to group Western European
languages in a set and then
quickly activate an individual
language/layout.
In this case, you will assign a
Hotkey (e.g. Left Ctrl) for
Western European set of
languages and another
Hotkey (e.g. Right Ctrl) for
Slavic languages, and an
Alternate Hotkey (Shift,

Ctrl+Shift etc.) to access  a desired layout within a set.  In this case, any
desired language/layout will be directly accessible.

The Edit button will invoke the Keyboard Layout Editor.

Setting Up ParaWin™ ME Properties
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Setting Up ParaWin™ ME Properties

Changing the Code Page

The code page is a table of numbers that used by the operating system
to relate the keys on the keyboard with the characters displayed on the
screen .
Windows 95, 98 or ME Setup installs the standard Windows and MS�DOS
code page pair for each specific language group.

The code page for Windows�based applications can be changed in
Windows 95, 98 or ME. However, the code page for MS�DOS�based
applications installed during the setup of the Windows 95, 98 or ME is
unchageble within Windows 95, 98 or ME.

ParaWin ME Pro was designed to overcome this limitation. It allows you to
select an alternate code page used by MS�DOS�based applications. This
functionality is very useful to you if your site uses an alternate character
set other than the default MS�DOS  level code page.

You know that you need an alternate code page if, after installing
Windows 95, 98 or ME, your MS�DOS�based applications do not display
characters properly, in other words, if the wrong characters appear as you
type in the MS�DOS prompt.

When you install ParaWin ME Pro, Setup will prompt you to select one of
the following standard character set  pairs to be used in your system.

       Windows CP         MS�DOS CP

Cyrillic 1251 866

Western 1252 437

Central European 1250 852

Baltic 1257 775

Turkish 1254 857

Greek 1253 737
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Setting Up ParaWin™ ME Properties

During the installation procedure you should select one of the offered
language settings.

You may change language settings later by accessing the ParaWin ME Pro
Properties:

• Open ParaWin ME Pro Properties window

• Click the Fonts Tab
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Setting Up ParaWin™ ME Properties

Selecting Desired Pair of Code Pages

• From the drop�down menu, select the desired system font character set
for Windows based applications .

This will automatically select a standard pair of code pages for both
Windows and MS�DOS based applications.

• Click the  Apply or OK button to finish setup.
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Setting Up ParaWin™ ME Properties

Changing the Code Page

To change the code page used for MS�DOS based applications:
• Select MS�DOS text conversion character set from the drop�down list.
• Click the Apply or OK button to finish setup

Changing the Code Page (Custom)

To change the code page used for MS�DOS based applications only,  while
retaining Windows�based system font, use the following procedure:
• Click the down�arrow and select Custom MS�DOS text conversion

character set.



25

The code page ID boxes will be enabled to accept a new ID entry .

Enter a desired code page ID into the DOS entry box.

Note: MAKE SURE THAT THE CODE PAGE NUMBER YOU ENTERED AND
THE      CODE PAGE NUMBER OF THE FILE STORED IN YOUR COMPUTER
ARE IDENTICAL. OTHERWISE, IT MAY LEAD TO THE UNPREDICTABLE
RESULTS INCLUDING YOUR SYSTEM LOCK UP.

For example: some systems are setup to use the code page 850 (MS�DOS
Latin 1) instead of 437 (MS�DOS United States).

• Click OK. ParaWin ME Pro will prompt you to restart your computer.

Setting Up ParaWin™ ME Properties
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Chapter 5
Keyboard Layout Editor

The Keyboard Layout Editor allows you to do the following:

• Open a file containing Windows 95, 98 or ME keyboard layout data (*.KBD)
or any of the keyboard layouts currently installed in your system

• View keyboard layouts and select a font for them

• Change a layout, create or delete a dead key combinations, assign and
reassign a dead�key completer

• Change a layout name

• Save changes made in a keyboard layout file and install it into your system
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You may access Keyboard Editor either from ParaWin ME Program group
menu or from the ParaWin ME Control panel.

• To start from the Program group menu, click the Start button, then select
Programs �> ParaWin ME �> Keyboard Editor.  Currently active layout will
be displayed as a template.

• To start Keyboard Editor from the ParaWin ME Pro Control panel, highlight
any layout from the list of the active layouts, click Properties �> Advanced
…�> Edit. Selected layout will be used as a template.

Basic Operations

The Keyboard Editor window consists of two parts.

 The upper part displays a code page table for the currently selected font

The lower part displays the current keyboard layout

Keyboard Layout Editor
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Creating or Loading Layout Template

• You can create a new keyboard layout  by choosing the New command
from the File menu. In this case you will start with an empty template.

• If you need to change the template, you may choose to load another one.
To load a layout for editing, use the Open command from the File menu
(Ctrl�O) and select the desired layout from the list of available layouts. If
the layout you would like to edit is not installed in your system, but you
know the name and the location of the keyboard data file  (extension
.KBD), you may load it by clicking the From file... button.

• If you want to load a currently active layout and view it using the Editor,
you may use the Load Active command from the File menu.

Saving and Activating Layout

• To save your newly created layout as a .KBD file, use Save or Save As
commands from the File menu.

• To activate a layout, use the Activate command from the File menu.

The layout name is shown above the keyboard chart, while the keyboard
layout file name is displayed on the caption bar.

Editing

To customize the keyboard layout, drag the characters from the character
table located in the upper part of the Editor window, and drop them onto
the keyboard keys of your choice, displayed in the lower part of the Editor
window.

A different  procedure could be used to assign a character to a key.

• Select a destination key by depressing it on your keyboard, or by clicking
the image of this key on the keyboard chart. A selected key will appear
pressed on the keyboard chart.

• Double�click the character to be placed, and it will drop onto a selected
key.

Keyboard Layout Editor
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The decimal (hexadecimal) value and the zoomed image of the character
assigned to the key  will appear in the right lower corner of the editing
window.

There are several keys on the keyboard chart that  cannot be modified. These
functional keys (“Shift”, “Caps”, “AltGr”) are used to change the keyboard
layout mode.

Customizing Application Window

• If the keyboard chart does not resemble your physical keyboard, go to
the Options menu, then select Keyboard Type and choose your actual
type.

Note: Selection of a keyboard type from this list will not affect the layout
itself � it only changes the way it is viewed.

• To change fonts for the character table and key caps, use the Fonts
drop�down list box.

Changing Layout Properties

The main keyboard properties are:  layout name and language.

To change these properties, go to Layout Properties in the Options menu
and make the necessary changes.

Keyboard Layout Editor
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Advanced Operations

The  Advanced tab in the Layout Properties opens a dialog box with
additional features.

To get to this window,  click on the Options menu in the Keyboard Editor
window, then select the Layout Properties.

Keyboard Layout Editor
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Caps Lock
The Caps Lock key can be used in the following three ways:

• Selectable Shift. In this mode, the Caps Lock key switches some (usually
alphabetic) keys into the shifted state, while the other keys remain in the
unshifted state. The keys for which the state has been changed by the Caps
Lock key have a special capitalization mark. This mark can be set On or
Off  either by clicking the right mouse button while pointing to the
appropriate key or via Edit menu.

• Total Shift.  In this mode the Caps Lock key operates as the Shift key with
fixed position, locking all the keys into a shifted mode. To release Caps
Lock, press either left or right Shift key. Pressing Caps Lock key for the
second time will not release it.

• Independent Mode. This mode allows the use of the Caps Lock as third
Shift state, which is independent from the other two states. Thus, for
example, you can set letter “a” to unshifted state, “A” to shifted state and
“@” to Caps Lock state using the same key.

Right Alt

While in the US keyboard layout, the left and right Alt keys have the same
functionality. In most European keyboard layouts the functionality of the
right  and left Alt keys differs. In this case, the right Alt key is called AltGr.
AltGr key switches keyboard to a special state equal to Ctrl+Alt state used in
the US keyboard layout. This mode is used for typing typographic marks,
special symbols and rare letters.

Dead Key
The key used in a sequential combination with the next pressed key to
produce an accented character is called Dead Key.

Note: Dead key by itself does not generate any character.

For example:
To type “Â” using the French layout, you may press the key “^” ( Dead Key)
followed by the key “A” which is called a Completer Key.

+             =

Keyboard Layout Editor
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If you use a layout with the Dead Keys function enabled (e.g. French), in
the  Advanced Option window, any of the two possible dead key modes,
then the lower part of the editor window will look a bit different.

Dead Keys on the keyboard chart are marked with black triangles in the
corners. You can convert any key to a Dead Key by placing a check mark in
the Dead Key box in the lower right section of the Keyboard Editor window.

When you select a predefined Dead Key, or check the Dead Key box, the
zoom box next to it changes into a new Dead Key. To edit the selected Dead
Key, you must click on it and then select another completer for this dead
key from. The procedure for editing  available completers for any dead key
is exactly  the same as for editing any other keyboard layout, i.e. either by
dragging a character onto almost any key on the keyboard or by double�
clicking a character designated to be used as an active key.

All assigned completers on the keyboard chart are shown in black; the keys
which are not completers are dimmed. If the check box Dead Key is cleared,
then all completers currently associated with the dead key are deleted and
the Dead Key is converted back into a normal key.

There are two Dead Key modes that can be set up in the Advanced Option
dialog window: “Assigned to characters” and “Assigned to keys”.

In the “Assigned to characters” mode the Dead Key function is correlated to
a specific character.
For example, if you mark a key with the character “^” as Dead Key and later
place this character onto another key, this newly assigned key automatically
becomes a dead key.

In the “Assigned to keys” mode the Dead Key function is correlated to a
specific key and not to the character. Hence, if you have several keys with
the same character, only those of them which were specifically designated
as “Dead Keys” will maintain the Dead Key functionality.

Keyboard Layout Editor
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Chapter 6
Technical Information

FAQ B ParaWin ME Pro

1. I have Multilanguage support installed on my computer.  Why
do I need ParaWin?

Multilanguage support is sufficient in case you want only to type and
print out a document using standard keyboard layouts and limited
number of fonts.

You need ParaWin to gain the ability to:

· Use most commonly used international keyboard layouts missing in
Windows 95, 98 or ME

· Customize the existing keyboard layouts

· Use foreign proofing tools and foreign language software

· Use more fonts

· View a keyboard layout on screen

· Get more Hotkey choices to switch between languages

· Alphabetically sort a database

2. I have the US version of Windows.  Will ParaWin completely
change my Windows interface into another language?

No. ParaWin only installs special system information into your
Windows system needed to support foreign languages. The Windows
and applications interface will remain original.  ParaWin will enable
you to type, use proofing tools or other language applications in any
of the supported languages.
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3. I have ParaWin installed on my computer.  Where can I find
the required characters on the keyboard?

ParaWin provides a Keyboard Viewer, with which the chosen keyboard
layout can be displayed on the screen at any time.
You also can obtain the Cyrillic Keytop Labels, the transparent stickers
with Russian, Ukrainian and Serbian letters, and add the Cyrillic
characters to the existing keyboard.

4. I use Pan European version of Windows.  Can I use ParaWin
to get access to foreign languages?

Yes.  You can use any language that ParaWin supports provided you
DON’T CHANGE System settings (System fonts character set) during
the installation.

5. I want to upgrade Windows 95 to Windows 98/ME.  Do I have to
upgrade ParaWin95 to ParaWin ME?

Absolutely.  ParaWin95 was developed in 1995 to provide the true
multilingual support for Windows 95.  Windows 98/ME implemented a new
technology for handling fonts and languages.  ParaWin ME was re�designed
to support ALL Windows 95, 98 or ME version.
Never try to install ParaWin95 to Windows 98 or ME, as this may lead to
undesirable results!

Technical Information
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Code Pages

Windows Central European (CP=1250)
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Windows Cyrillic (CP=1251)

Technical Information
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Windows Western European (CP=1252)

Technical Information
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Windows Greek (CP=1253)

Technical Information
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Windows Turkish (CP=1254)

Technical Information
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Windows Baltic (CP=1257)

Technical Information
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Technical Information

Font Set included in  ParaWin ME Pro Package

CourierTT  Baltic
ĀāÄäĄąĒēĘę��
���ÕõÖöÜüŲųČčŠšŽžŪū

NewtonTT  Baltic
ĀāÄäĄąĒēĘęĢģĶķĻļÕõÖöÜüŲųČčŠšŽžŪū

PragmaticaTT  Baltic
ĀāÄäĄąĒēĘęĢģĶķĻļÕõÖöÜüŲųČčŠšŽžŪū

CourierTT  Cyrillic

АаБбВвГгЖжЂђЋћЉљЊњЏџЃѓҐґЎўЄєЇїЈј

NewtonTT  Cyrillic
АаБбВвГгЖжЂђЋћЉљЊњЏџЃѓҐґЎўЄєЇїЈј

PragmaticaTT  Cyrillic
АаБбВвГгЖжЂђЋћЉљЊњЏџЃѓҐґЎўЄєЇїЈј

CourierTT  Central European
ÁáĂăÇçČč��ËëÍ�Î�Ð�ŇňÓóŘřŮůÝýŢţŔŕ

NewtonTT  Central European
ÁáĂăÇçČčĘęËëÍíÎîĐđŇňÓóŘřŮůÝýŢţŔŕ

PragmaticaTT Central European
ÁáĂăÄäĆćÇçČčĘęËëÍíÎîĐđŇňÓóŘřŮůÝýŢţŔŕ
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CourierTT Greek
ΑαΒβΓγΔδΕεΖζΗηΘθΙιΚκΛλΜμΝνΞξΟοΠπ

NewtonTT Greek
ΑαΒβΓγΔδΕεΖζΗηΘθΙιΚκΛλΜμΝνΞξΟοΠπ

PragmaticaTT Greek
ΑαΒβΓγΔδΕεΖζΗηΘθΙιΚκΛλΜμΝνΞξΟοΠπ

CourierTT Turkish
ÂâÄäÇç ÎîÖö ÛûÜüƒ£¥ÆæŒœ¥£ƒ

NewtonTT Turkish
ÂâÄäÇçĞğİıÎîÖöŞşÛûÜüƒ£¥ÆæŒœ¥£ƒ

PragmaticaTT Turkish
ÂâÄäÇçĞğİıÎîÖöŞşÛûÜüƒ£¥ÆæŒœ¥£ƒ

CourierTT Western European
ÀàÁáÅåÆæÇçÈèÉéÍíÎîÐðÑñÒòÞþßÿ¿œ¥£ƒ

NewtonTT Western European
ÀàÁáÅåÆæÇçÈèÉéÍíÎîÐðÑñÒòÞþßÿ¿œ¥£ƒ

PragmaticaTT Western European
ÀàÁáÅåÆæÇçÈèÉéÍíÎîÐðÑñÒòÞþßÿ¿œ¥£ƒ

Technical Information
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